
HP Project and Portfolio Management Center
Software Version: 9.11
Release Notes

Document Release Date: October 2010

Software Release Date: October 2010



Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

For information about third-party license agreements, see the Open Source and Third-Party License Agreements on 
the HP Software Manuals Web site at h20230.www2.hp.com/selfsolve/manuals.

To view open source code, see the <PPM_Home>/integration/freeware/ directory of your PPM Center 
installation.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1997-2010 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Intel®, Intel® Itanium®, Intel® Xeon®, and Pentium® are trademarks of Intel Corporation in the U.S. and other 
countries.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, Windows® XP, and Windows Vista® are U.S. registered trademarks of Microsoft 
Corporation.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

Software version number, which indicates the software version

Document release date, which changes each time the document is updated

Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.
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Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests

Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Overview of PPM Center Version 9.11
This document provides an overview of the changes made to HP Project and 
Portfolio Management Center (PPM Center) for version 9.11 (Service Pack 1). 
It contains important information not included in the manuals. The sections 
New Features, Enhancements, Integrations, Certifications, and Fixes, and 
Known Problems and Limitations provide information about the changes 
introduced with the new features, enhancements, certifications, and fixes for 
PPM Center version 9.11.

Protecting Your Deployment from Security Vulnerabilities

Make sure you take the necessary precautions to protect your PPM Center 
deployment from general security vulnerabilities, especially those related to 
Web server and related infrastructure vulnerabilities. Patch and configure your 
Web server’s operating system and DNS servers to prevent malicious attacks 
that could put your organization and data at risk. You can take such steps as 
disabling unused ports or enabling SSL in your environment. Consult your 
Web server vendor for the latest patches to prevent harmful attacks such as 
cross-site scripting.
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In this Version

The following new features are included in PPM Center version 9.11:

Hierarchical Selection

User Data for Resources

The following enhancement is included in PPM Center version 9.11:

User data for positions

The following certifications are included in PPM Center version 9.11:

Support for Universal CMDB versions 9.00 and 9.01

Support for CCRM 9.1
8



Documentation Updates

The first page of this release notes document contains the following identifying 
information:

Version number, which indicates the software version. 

Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent 
edition, visit the following URL:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register 
for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales representative for 
details.

To view files in PDF format (*.pdf), Adobe Reader must be installed on your system. 
To download Adobe Reader, go to: http://www.adobe.com.
Overview of PPM Center Version 9.11 9
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Installation Notes

This procedure includes steps that are valid for the Brand Version 9.11.  To 
install the PPM Center 9.11:

1. Back up your database.

2. Stop the PPM Server. The Service Pack cannot be installed on an active 
server.

3. Copy the Service Pack file ppm-911-SP1.jar to the <PPM_Home> 
directory. This is the directory where the PPM Server is installed.

4. Change to the <PPM_Home>/bin directory.

5. Start the installation using the following command:  
sh ./kDeploy.sh -i SP1

6. Follow the on-screen instructions to complete the Service Pack installation.

7. Compile the new JSP files using the following command:  
sh ./kJSPCompiler.sh

8. Start the PPM Server.

Software and Hardware Requirements

Before you install PPM Center version 9.11, make sure that your system meets 
the minimum requirements, as described in the System Requirements and 
Compatibility Matrix, available at the HP Manuals site.

The current release of PPM Center does not support table or tablespace compression 
in Oracle. If you use compressed tables or compressed tablespaces, the upgrade 
scripts will fail.
10



Regenerating Web Service Stubs for Integrating with HP 
ServiceCenter

If you have integrated your PPM Center deployment with HP ServiceCenter, 
you can modify which fields are available through Web services, but you must 
regenerate the Web service stubs for the integration after installing any PPM 
Center service pack. 

After installing the service pack, regenerate the Web service stubs in the PPM 
Server from the new Web Services Description Language (WSDL) descriptor 
as follows:

1. Navigate to the <PPM_Home>/bin/sdi directory on the PPM Server.

2. Run the script:

sh ./kGeneratePeregrineStub.sh <wsdl-url> <PPM_Server_Name> 

where

o <wsdl-url> represents the ServiceCenter WSDL URL for Change 
Management.

o <PPM_Server_Name> represents the subdirectory of <PPM_Home>/
server specified during installation as the value for the KINTANA_
SERVER_NAME parameter in the server.conf file. (It is not necessarily 
the actual host name of the server.) When generated, the stubs will be 
placed under this subdirectory.

For example, run the script:

sh ./kGeneratePeregrineStub.sh http://host:12670/
ChangeManagement?wsdl kintana 

The stub configuration might fail if the host is not resolvable by name. To resolve 
the host by name, make an entry in the hosts file for the machine you want to 
connect. See the documentation for your operating system for the location of the 
hosts file.
Overview of PPM Center Version 9.11 11



New Features

The following new features are included in PPM Center version 9.11:

Hierarchical Selection

User Data for Resources

Hierarchical Selection

Hierarchical selection is the ability to list selectable field values in the form of 
a hierarchy or tree. If the field values can be defined hierarchically, the 
selectable field values can be presented to the user in a hierarchical list. For 
example, when a resource pool (ResourcePool_1a) is created, a parent resource 
pool can be set. If a parent resource pool (ResourcePool_1) is configured to 
ResoucePool_1a, in the hierarchical selection, Resource_Pool_1a appears as a 
child to ResourcePool_1. 

Figure 1-1. Hierarchical selection example

Hierarchical selection must be enabled by the system administrator and is only 
available for the Auto Complete List validation. 
12



Upgrade Considerations

Hierarchical selection can be enabled on upgraded Auto Complete List 
validations. By default, hierarchical selection is disabled.

Enabling Hierarchical Selection

Hierarchical selection can be enabled for Auto Complete List validations only. 

To enable hierarchical selection:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench.

The PPM Workbench opens.

3. On the shortcut bar, click Configuration > Validations.

4. From the Validations Workbench, 

If you are creating a new validation, click New Validation. Enter the 
required fields (Name and Reference Code). For Component Type, select 
Auto Complete List. For Validation By, select SQL - Custom.

If you are updating a validation, click List, and then find and double-click 
on the validation.

5. Select the Enable Hierarchical Selection? checkbox. The Hierarchical 
Display tab is enabled.

If you cannot select the Enable Hierarchical Selection? checkbox, hierarchical 
selection cannot be enabled for the validation.
Overview of PPM Center Version 9.11 13



6. From the Hierarchical Display tab, set the following fields:

7. Enter any other information for the validation.

8. Select OK.

If a field uses this validation, the hierarchical selection icon (  ) appears next 
to the field.

Hierarchical Display Tab Query Example

A basic SQL query used in the Hierarchical Display tab consists of the 
following:

Select <PrimaryIDColumn> id, 
<ParentIDColumn> parentId,
<FolderDefinition> isFolder,
<BusinessKeyColumn> name,
<DisplayInfo_1>, <DisplayInfo_2>, ... , <DisplayInfo_n>
from <Table_1>, <Table_2>, ... , <Table_n>
where <Condition_1> and <Condition_2> and ... and <Condition_n> 
and NVL(<ParentIDColumn>,0) = :parentId

Field Description

Is folder selectable?

In a hierarchical selection, a parent node may be a 
container for selectable values or the parent node 
may be a selectable value.
Enable this checkbox if the parent node is a 
selectable value. Selecting this checkbox allows the 
parent node value to be selected as the field value.
Disable this checkbox if the parent node is only a 
container or folder. Disabling this checkbox does not 
allow the parent node value to be selected as a field 
value.

SQL

Provide the Select statement that queries the 
database information. An ending semicolon is not 
necessary. See Hierarchical Display Tab Query 
Example for more information.
14



where

<PrimaryIDColumn> Required. Column name whose data type is 
numeric. Identifies the object that is 
displayed in the hierarchical selection list, 
such as a resource pool      
(rpl.resource_pool_id) or skill 
(sk.skill_id).

<ParentIDColumn> Required. Column name whose data type is 
numeric and is a parent. Identifies the 
parent of the selected object such as a 
parent resource pool               
(rpl.parent_resource_pool_id) or 
parent skill (sk.parent_skill_id).

<FolderDefinition> Required. A column name (such as a flag) 
or sub-query that determines if the object is 
a folder. The value or result must be either 
‘Y’ or ‘N.’

An example of a column name is:     
sk.is_skill_folder_flag

An example of a sub-query is: 
decode(sign((select 
count(rpl2.resource_pool_id) from 
RSC_RESOURCE_POOLS rpl2 where 
rpl2.enabled_flag='Y' and 
rpl2.parent_resource_pool_id= 
rpl.resource_pool_id)),1,'Y','N')

<BusinessKeyColumn> Required. The user-defined name of the 
object that is displayed in the hierarchical 
selection list.
Overview of PPM Center Version 9.11 15



The following is the hierarchical display query used by the RSC - Enabled 
Resource Pools validation:

select rpl.resource_pool_id id, 

rpl.parent_resource_pool_id parentId, 

decode(sign((select count(rpl2.resource_pool_id) from       
RSC_RESOURCE_POOLS rpl2 where rpl2.enabled_flag='Y' and 
rpl2.parent_resource_pool_id=rpl.resource_pool_id)),1,'Y','N') 
isFolder, 

rpl.resource_pool_name name, 

krsc_utils.get_pool_managers_list(rpl.resource_pool_id), 
rpl.description 

from RSC_RESOURCE_POOLS rpl 

where rpl.enabled_flag='Y' and                   
NVL(rpl.parent_resource_pool_id, 0) = :parentId

Using Hierarchical Selection

Hierarchical selection is enabled for a field when the hierarchical selection 
icon (  ) appears next to the field. Clicking the hierarchical selection icon 
opens a list of selectable field values in the form of a hierarchy or tree.

<DisplayInfo_1>, ... , 
<DisplayInfo_n>

Optional. Additional information about the 
object to be displayed in the hierarchical 
selection list.

<Table_1>, ... , <Table_n> Required. The name of the table from 
which to query. For example,                
RSC_RESOURCE_POOLS or RSC_SKILLS.

<Condition_1> and ... and 
<Condition_n>

Conditions to be met in order for the object 
to be selected to display in the hierarchical 
selection list. 

At a minimum, you must include the 
following condition: 
NVL(<ParentIDColumn>,0) = :parentId
16



If the field allows only one value to be entered, you can choose only one value 
from the hierarchical selection. If a value exists in the field, the selected value 
replaces the existing value.

If the field allows more than one value to be entered, you can choose one or 
more values from the hierarchical selection. If a value exists in the field, the 
selected values are appended to the existing value.

User Data for Resources

Pages in PPM Center display a set of standard fields for collecting and 
displaying information. User data is the set of custom fields that can be defined 
by the system administrator.

If you want to include additional fields in a resource’s page, you can define 
them in the User Data Workbench.

Resource user data are customizable resource attributes that are added to the 
Details tab in a resource’s page. The system administrator configures the 
resource attributes that are displayed in a resource’s page and the resource can 
modify the values of these resource attributes from the Details tab.

Resource user data is not available in the Search Resources page nor can they 
be modified for multiple resources simultaneously.

To configure user data:

1. Log on to PPM Center.

2. Select Open > Administration > Open Workbench.

The PPM Workbench opens.

3. From the shortcut bar, select Configuration > User Data.

The User Data Workbench opens.

4. Click List.

The Results tab opens with the available user data types.

5. To configure resource user data, select Resource User Data and click Open. 
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The User Data Context window opens.

6. To add a field, click New.

The Field: New window opens.

7. From the Field: New window, do the following:

a. Configure up to 100 fields. Enter the following information: 

i. In the Field Prompt box, type the label to display for the new field.

ii. In the Token box, type an uppercase text string to use to identify 
this field.

The token name must be unique to the specific user data. An 
example token name is ASSIGNED_TO_USER_ID.

iii. In the Description box, you can enter text that describes what the 
field captures and how it is to be used.

iv. To enable the new field, leave Enabled selected.

v. In the Validation box, enter or select the validation logic to use to 
determine the valid values for the field. 

This can be a list of user-defined values, a rule that the result must 
be a number, and so on.

vi. The Component Type field indicates the field type (list, free-form 
text field, and so on). This read-only field is derived from the 
validation you selected.

vii. If the field lists selectable items, and you want users to be able to 
select more than one of these, select Multiselect.

If you select Multiselect, the PPM Workbench displays a dialog box 
that lists limitations imposed on multiselect user fields. 

If you selected Multiselect, make a note of the limitations, and then 
click Yes.

b. On the Attributes tab, enter the following information: 
18



i. In the User Data Col list, select the internal column in which the 
field value is to be stored. 

You can store information in up to 100 columns, which means that 
you can create up to 100 custom fields for resources. No two fields 
in user data can use the same column.

ii. To make the new field read-only at all times, in the Display Only 
list, select Always. To make the field editable at all times, select 
Never.

iii. To make the field visible to users, next to Display, leave Yes 
selected. To hide the field, select No.

iv. To make the field required (the user must specify a value) at all 
times, in the Required list, select Always. To make the field optional 
at all times, select Never.

c. To configure a default value for the user data field, open the Default tab 
and enter the following information: 

i. To indicate that the field is to have a default value, in the Default 
Type list, do one of the following:

o To specify that the field default is to be a constant value, select 
Constant.

o To specify that the field default is to have no default, select 
None.

ii. If you specified a constant default type, then in the Visible Value 
list, select the constant value. 

8. To save your changes and create another field, click Add. The Field 
window clears so that you can create another new field. Repeat step 7, as 
needed.

To save your changes and close the Field window, click OK.

9. From the User Data Context window, use the Layout tab to rearrange the 
fields as you want the user to view them from the Details tab.

10. Click OK.
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Enhancements, Integrations, Certifications, and Fixes

This section includes information about the enhancements, integrations, 
certifications, and fixes in PPM Center version 9.11.

Enhancements

The following enhancement is included in PPM Center version 9.11:

User data for positions

With this enhancement, users now may add up to 100 fields.

Certifications

The following certifications are included in PPM Center version 9.11:

Support for Universal CMDB versions 9.00 and 9.01

Support for CCRM 9.1

Support for Universal CMDB versions 9.00 and 9.01

This certification provides Universal CMDB versions 9.00 and 9.01 support 
for the following PPM Center integration solutions:

PPM Center integration with Universal CMDB for Service Portfolio

Note the following impact to configuration:

o Define the UCMDB_SERVER_VERSION parameter in the 
server.conf file with the proper value. For example, 9.00.

For more information about this integration solution, see the HP Solution 
Integrations Guide.

PPM Center integration with Universal CMDB (using ALM)

Note the following impacts to installation and configuration:
20



o PPM server must have the same domain name as the Universal CMDB 
server. For example, if the Universal CMDB server domain name is 
abc.chn.hp.com, the PPM server must be xyz.chn.hp.com, such as 
anbo.chn.hp.com.

o PPM server must be running on the save protocol as the Universal 
CMDB server. For example, if the Universal CMDB server is running 
on HTTPS, the PPM server must be running on HTTPS as well.

o Define the UCMDB_SERVER_VERSION parameter in the 
server.conf file with the proper value. For example, 9.00.

o Consult your Universal CMDB server administrator and define the 
following new parameters in the server.conf file for impact analysis 
report:

o Starting from PPM Center version 9.11, you can encrypt the Universal 
CMDB password with PPM’s encryption tool kEncrypt.sh.

To encrypt the password, 

i. Go to <PPM_Home>/bin/ucmdb directory.

ii. Run the following:

sh kEncrypt.sh -t admin

The encrypted text returns. 

iii. Copy and paste the encrypted text as the value for parameter 
UCMDB_PASSWORD in the server.conf file.

Parameter Description

IMPACT_ANALYSIS_REPORT_
CATEGORY 

Impact analysis report 
category, for example, UCMDB

IMPACT_ANALYSIS_REPORT_
SEVERITY 

impact analysis report 
severity, for example, 
Warning(1)

UCMDB_NAME_FIELD The field that stores the CI 
name, for example, name 
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For more information about the integration solution, see the HP Solution 
Integrations Guide.

Support for CCRM 9.1

This certification provides Change Configuration and Release 
Management (CCRM) 9.1 support for the following PPM Center 
extensions:

o PPM Project Task to SM RFC Integration

o SM RFC to PPM Project Task Integration

Make sure that these two extensions support Service Manager 9.20, which is 
required for CCRM 9.1 support.
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Fixes

The following fixes are included in PPM Center version 9.11:

Costing - Staffing Profile Budget Synch

Dashboard

Integrations - SM RFC

Platform

Global ID Problem Description

N/A Exception appears when editing header of any Staffing Profile that was 
synchronized with Financial Summary (budget) before upgrade. (QCCR1L27897)

Global ID Problem Description

N/A Discrepancies in indexes between upgrade and fresh. (QCCR1L27989)

Global ID Problem Description

N/A Task finish date is changed after synchronization to SM RFC. (QCCR1L28357)

Global ID Problem Description

N/A Discrepancies in indexes between upgrade and fresh. (QCCR1L27408)

N/A Cannot add security group to users from workbench. (QCCR1L27785)
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Resource Management

Time Management

Global ID Problem Description

QCIM1L28292 
4620109634

Error occurs when adding resources to a project or saving tasks in work plan on a 
PPM Center instance with French (Canada) Formatting Options in User Profile and 
CAD currency. (QCCR1L28441)

N/A Discrepancies in indexes between upgrade and fresh. (QCCR1L27990)

Global ID Problem Description

N/A Discripancises (missing) in indexes from fresh install to upgraded instance for  
TM_TIME_SHEET_LINES and PM_WORK_PLANS. (QCCR1L27986)
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Known Problems and Limitations

The following problems and limitations are known to exist in PPM Center 
version 9.11 (or other software, as indicated). The problems are categorized by 
the affected product area. If a problem has an assigned internal tracking 
number, that tracking number is provided (in parentheses) at the end of the 
problem description.

Center Management for Quality Center

Installation

LIMITATION CMQC bundle does not support Oracle 11.2.0.1. Deployment of the bundle using 
that environment will result in an error. (QCCR1L27892)

WORKAROUND Oracle 11.1.0.7 is supported.

LIMITATION Because the PPM Center installation and configuration wizards are not fully 
localized in Chinese and Portuguese (Brazilian) languages, some of the text in 
wizard steps are shown in English only during installation or system configuration. 
(QCCR1L27173)

WORKAROUND None.

LIMITATION After you install PPM Center and then install language packs, the Import 
Notifications section of all of the language pack deployment logs saved to the 
<PPM_Home>\logs\Lang_Pack\ directory contain the error “Fail to deploy 
NotifBody...”
These error messages have no functional significance and can be ignored. 
(QCCR1L27539)

WORKAROUND None.
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Dashboard

Integrations

Integration with Quality Center (ALM)

PROBLEM
Any PPM Center portlets that contain the word “program” do not display the new 
Chinese translation for “program” and instead display the old Chinese translation for 
“program”. (QCCR1L27636)

WORKAROUND None.

PROBLEM Using Internet Explorer and Microsoft Project 2007, opening a work plan in 
Microsoft Project from PPM Center generates a lock file for the Microsoft Project 
file. However, after closing the Microsoft Project file, the lock file is not reset. When 
opening the same work plan in Microsoft Project from PPM Center (without 
restarting Internet Explorer), the File in Use message is displayed and the Microsoft 
Project file can only be opened in read-only mode (you may also choose to be 
notified when the file is no longer in use). (QCCR1L25812)

WORKAROUND After closing the Microsoft Project file you can reset the lock file by doing one of the 
following:

Delete the lock file. From any Internet Explorer window, do the following:
1. Select Tools > Internet Options.
2. In the General tabbed area, in the Temporary Internet files section, click Delete Files.
3. From the Delete Files dialog, click OK.
4. From the Internet Options dialog, click OK.

Restart Internet Explorer
Restart the system on which Internet Explorer is running.

LIMITATION Synchronization of workflows is not supported. PPM Center and Quality Center 
each has its own workflow to manage the process of defect handling. When driving 
the workflows from both sides, and moving a defect to another step in PPM Center's 
workflow, it cannot be reflected in Quality Center’s workflow, and vice versa.

WORKAROUND None available at this time.

LIMITATION Bi-directional synchronization of drop-down list values is not supported. 
(QCCR1L25919)
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Integration with Universal CMDB (ALM)

WORKAROUND None available at this time.

LIMITATION Comments and description format tags are displayed in PPM Center directly in 
normal text. (QCCR1L25815)

WORKAROUND None available at this time.

LIMITATION If a date-type field in Quality Center has a special format, the mapping field in PPM 
Center must have the same format, otherwise the date will not be synchronized to 
PPM Center correctly. (QCCR1L25917)

WORKAROUND None available at this time.

LIMITATION Quality Center support multi-value fields, such as target release and target cycle. 
However, current design of PPM Center does not support mapping a PPM field to a 
multi-valued Quality Center field.

WORKAROUND None available at this time.

PROBLEM If a user selects more CIs than the maximum allowed CI number, an error message 
will pop up and it returns to the CI selector, but the selected CIs are gone. The user 
needs to select them again.

WORKAROUND None available at this time.

PROBLEM View Type, View Tree Name, and View TQL Name are deprecated in Universal 
CMDB 9.0, thus their values are not available.

WORKAROUND None available at this time.

LIMITATION Due to Universal CMDB 9.0 limitation, PPM server must have the same domain 
name as the Universal CMDB server. For example, if the Universal CMDB server 
domain name is abc.chn.hp.com, the PPM server must be xyz.chn.hp.com, such as 
anbo.chn.hp.com.

WORKAROUND None available at this time.

LIMITATION Due to Universal CMDB 9.0 limitation, PPM server must be running on the save 
protocol as the Universal CMDB server. For example, if the Universal CMDB server 
is running on HTTPS, the PPM server need to be running on HTTPS too.

WORKAROUND None available at this time.
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HP Demand Management

PROBLEM If a request contains a rule that uses KNTA_MULTI.Find_User_full_
names([SYS.USER_ID]) from sys.dual, saving the request may fail or 
removing associated entities from the request may fail. (QCCR1L24349)

WORKAROUND Use KNTA_MULTI.Find_UserNames([SYS.USER_ID]) from sys.dual 
instead.

LIMITATION A token unparseable error occurs when creating a request of a request type, where 
its validation referenced a non-existing token. (QCCR1L27418)

WORKAROUND When you specify a valiation for your request type, report type, or object type, make 
sure that the token(s) referenced by the valiation already exist.

LIMITATION When Text Field is set to “is equal to” the value of an Auto Complete List or Drop 
Down List value in the Dependencies section of the Rules tab in the request type 
workbench, the dependencies do not work; However, if the Text Field is set to 
match the code of the Auto Complete List or Drop Down List, the dependencies 
work well. (QCCR1L27020)

WORKAROUND Considering the fact that Auto Complete List and/or Drop Down List values can be 
localized, which will then cause consistency issue for the dependencies, HP 
recommendes you to match Text Field code to the code of Auto Complete List or 
Drop Down List when you set up request type field dependencies.
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HP Deployment Management

PROBLEM File transfer from source environment to destination environment using Reflection 
for Secure IT for Unix (version 7.1) server fails when the environments were 
configured in a workflow execution step. (QCCR1L24976)

WORKAROUND To use Reflection for Secure IT for Unix server to transfer files successfully, 
1. Create a new Environment User Data using the following values: 

Field Prompt: DISABLE_SCP_FILENAME_QUOTE
Token: DISABLE_SCP_FILENAME_QUOTE
Enabled: Yes
Validation: Yes No Radio Buttons
User Data Column: Select a value from the drop down list.
Display: Yes
Display Only: Never
Required: Never 

Then, in the Environment you want to use, enable the newly created user data.
For more information about creating and enabling user data, see the HP Deployment Management 
Configuration Guide.

2. Note down the Server environment and Client environment values you used in step 1.

3. Configure the workflow execution step and use the Server environment and Client environment 
values you noted down earlier for Source Environment and Dest Environment fields. 
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HP Portfolio Management

HP Program Management

Multilingual User Interface (MLU)

PROBLEM If you used environment tokens in Object Type with special command ksc_copy_
server_server and set the Source and Destination environments as its 
parameters, file transfer from source environment to destination environment with 
Reflection for Secure IT for Unix (version 7.1) server fails. (QCCR1L27758)

WORKAROUND Modify the environment settings by following the instructions described in the 
WORKAROUND for QCCR1L24976.

PROBLEM Transaction History and Notes History cannot be enabled in the Associated 
Programs field of a PFM - Asset, PFM - Project, or PFM - Proposal request header 
type or a copy of one of these request header types. Selecting Yes or No does not 
enable these auditing features. (QCCR1L26865)

WORKAROUND None available at this time.

PROBLEM Program risk request types are not available.

WORKAROUND Program risk request types are part of the Best Practices content. Best Practices 
must be installed/re-installed in order to use this content.

PROBLEM When deploying language packs, the logs will show the following error for all 
languages, except for the system language:
[java] java.sql.SQLIntegrityConstraintViolationException: 
ORA-02291: Integrity-Constraint (GEEK_01.KNTA_NOTIFICATIONS_
LOC_FK) violated

This error has no functional impact. (QCCR1L27539).

WORKAROUND None.
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HP Project Management

PROBLEM When using Internet Explorer, using tooltips in the work plan may display a 
message about the page containing secure and nonsecure items, prompting you to 
continue. Each time a work plan is redrawn or refreshed, using tooltips in the work 
plan displays this message. (QCCR1L24383)

WORKAROUND This message may be disabled from the Security Settings of the browser.
From Internet Explorer:

1. Select Tools > Internet Options.
2. Select the Security tab.
3. Select the Internet Web content zone.
4. Click Custom Level.
5. Under Miscellaneous and Display mixed content, select Enable.
6. Click OK.
7. Click OK.
8. Restart Internet Explorer.

PROBLEM When a user (such as a project manager or summary task owner) edits a task’s 
resources directly from the work plan page, resources who are already assigned to 
the task are deleted if they do not belong to a resource pool managed by that user. 
Resources who have entered actual efforts for the task are not deleted. 
(QCCR1L26798)

WORKAROUND Assign all users who manage resource assignments for the project as a resource 
pool manager to all resource pools that are associated with the project.

PROBLEM If a user edits a task’s external predecessor from the work plan page, when the task 
is saved, the external predecessor is deleted. (QCCR1L27616)

WORKAROUND Use the Task Details page to edit a task’s external predecessors. Do not edit 
external predecessors from the work plan page.

PROBLEM When exporting a work plan to both PDF and Excel, if the work plan has a task with 
a name that contains double-byte numbers, the exported PDF differs from the 
exported Excel. In the exported PDF, the task name does not contain the 
doublebyte numbers. (QCCR1L14109)

WORKAROUND None.
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Operational Reporting

PROBLEM Opening a linked report from the parent WEB Intelligence report results in the 
removal of data from the parent report results. This happens only if you open a 
linked report after you export the parent report to Excel and save it. Thereafter, if 
you click the refresh button on the parent report prompt, saved filter values are lost. 
(QCCR1L16514)

WORKAROUND After you export a parent report to Excel, re-run the report with new prompt values, 
and then open the linked report without exporting it to Excel.

PROBLEM Although you can run the operational reports that HP supplies, you cannot create or 
edit reports in InfoView without security risk. If you attempt to create or edit a Web 
Intelligence document in InfoView, a dialog box displays the message, “The 
application’s digital signal has an error. Do you want to run the application?” 
(QCCR1L25229)

WORKAROUND Do not attempt to create or edit a Web Intelligence document in InfoView. If you do, 
then after the message, “The application's digital signal has an error. Do you want to 
run the application?” is displayed, click Cancel.

PROBLEM A database error occurs if you provide a query prompt value that contains a 
backslash (\) character. (QCCR1L16066)

WORKAROUND If you provide the prompt value manually, type two backslash characters instead of 
just one.

PROBLEM If you export a Web Intelligence document that contains Asian characters to PDF 
format, the Asian characters are not exported. (QCCR1L25538)

WORKAROUND None.

PROBLEM In order to display a long text string so that it wraps to fit the width of a cell, InfoView 
adds a hyphen to the string in Web Intelligence documents. If a text string such as 
this contains Asian or particular European (Russian, Turkish) characters, InfoView 
places the hyphen(s) incorrectly so that some characters are not displayed in report 
results. This can occur in the Time Sheet Compliance report if the resource pool 
names are long and contain Asian characters. (QCCR1L25537)

WORKAROUND Increase the width of cells in the report.

PROBLEM If you modify the fiscal period definition in PPM Center after you set up the 
Operational Reporting schema and load PPM Center data, the changes to the fiscal 
period definition are not brought into in the Operational Reporting schema during 
subsequent incremental ETL operations. (QCCR1L27596)
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Other

WORKAROUND Re-run the setup and load scripts to bring your changes to the fiscal period 
definition into the Operational Reporting schema.

PROBLEM HP-supplied operational reports can sometimes omit result rows or incorrectly total 
row values if the results require a large number of rows to display.
If you run an HP-supplied operational report and you specify query filter options that 
include a wide range of data that generate a large number of result rows, the last 
few rows and totals may be hidden by the Query Filter options text in the report 
results displayed. (QCCR1L26958)

WORKAROUND Run the report from a new Web browser session.

PROBLEM

If the PPM Center database schema is restored from a data dump in which 
BusinessObjects was already configured, and the BusinessObjects scripts are re-
run on the restored dump, the setup script cannot automatically drop the Oracle 
Change Data Capture (CDC) tables. 

WORKAROUND

If the PPM Center database schema is restored from a data dump in which 
BusinessObjects was already configured, and you must re-run the BusinessObjects 
scripts on the restored dump, make sure that you manually drop all of the CDC 
tables before you re-run the BusinessObjects setup script.

PROBLEM
HP has noticed Oracle Internal Errors (Ora 600) for certain test data sets when 
accessing the HP PPM Operational Reports or during the process of ETL in the HP 
PPM Operational Reports.

WORKAROUND If you encounter such errors, upgrade your Oracle Database software to version 
11.2.0.1 or later to fix the problem.

After you install PPM Center version 9.11, you can locate the packages rpt_sync_
objects.plb and rpt_request_update_dimension.plb under the 
OpsReporting folder, and then deploy these two packages on your Reporting DB 
schema to replace the previous version.

LIMITATION
Because Oracle Enterprise DB Server is not supported on VMware, PPM Center 
(including the Operational Reporting solution) does not work with Oracle Enterprise 
DB Server on VMware.

WORKAROUND None.
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